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Abstract: The retina encodes visual scenes by trains of action potentials that are sent to the
brain via the optic nerve. In this paper we describe a new free access user-end software allowing
to better understand this coding. It is called PRANAS (https://pranas.inria.fr), standing for
Platform for Retinal ANalysis And Simulation. PRANAS targets neuroscientists and modelers
by providing a unique set of retina-related tools. PRANAS integrates a retina simulator allowing
large scale simulations while keeping a strong biological plausibility and a toolbox for the analysis of
spike train population statistics. The statistical method (entropy maximization under constraints)
takes into account both spatial and temporal correlations as constraints, allowing to analyze the
e�ects of memory on statistics. PRANAS also integrates a tool computing and representing in
3D (time-space) receptive �elds. All these tools are accessible through a friendly graphical user
interface. The most CPU-costly of them have been implemented to run in parallel.
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PRANAS: Une nouvelle plateforme pour l’analyse et la
simulation de rØtines

RØsumØ : La rØtine encode les scŁnes visuelles par des trains de potentiels d’action qui sont
envoyØs au cerveau via le nerf optique. Dans cet article, nous dØcrivons un nouveau logiciel libre
d’accØs qui permet de mieux comprendre ce codage. Il s’appelle PRANAS (https://pranas.inria.fr),
ayant pour signi�cation Platform for Retinal ANalysis And Simulation. PRANAS cible les neu-
roscienti�ques et les modØlisateurs en fournissant un ensemble unique d’outils liØs à la rØtine.
PRANAS intŁgre un simulateur de rØtine permettant des simulations à grande Øchelle tout
en conservant une forte plausibilitØ biologique et une boîte à outils pour l’analyse statistique
des trains d’impulsion dans une population de neurones. La mØthode statistique (maximisation
de l’entropie sous contraintes) prend en compte les corrØlations spatio-temporelles comme con-
traintes, permettant d’analyser les e�ets de la mØmoire sur les statistiques. PRANAS intŁgre
Øgalement un outil de calcul et de reprØsentation en 3D (temps-espace) des champs rØcepteurs.
Tous ces outils sont accessibles grâce à une interface utilisateur conviviale. Les plus coßteux
d’entre eux en terme de temps de calculs ont ØtØ implØmentØs pour fonctionner en parallŁle.

Mots-clØs : Retina simulator, spike train statistics, population coding, maximum entropy,
Gibbs distributions, large scale spiking activity, spike train generation, multi-electrode array
recordings
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1 Introduction

The retina is one of the most developed sensing devices [21, 34, 35]. It transforms the incoming
light into a set of electrical impulses, called spikes, which are sent asynchronously to higher
level structures in the visual cortex through the optic nerve. Although Cajal’s neuron doctrine
was postulated more than one century ago, how information is encoded and transmitted by
neurons is still not entirely understood today. Especially, the role of spatio-temporal correlations
in population coding raises up deep theoretical and practical questions that are far from being
answered [49, 6], particularly for the visual information transmitted from the retina to the visual
cortex. To address these questions and make progress in their understanding, one needs to
develop joint modeling and experimental studies with e�cient software to analyse data. In
this paper we present a new Platform for Retinal ANalysis And Simulation called PRANAS
(https://pranas.inria.fr). It was designed as a user-friendly tool dedicated to neuroscientist
community in a large sense, i.e., not only experienced computational neuroscientists. It has
two main goals, analyse retina data, especially spatio-temporal correlations, and simulate the
spike response of the retina to a visual �ow. This makes this tool a unique platform to better
understand how the retina works.

The �rst goal of PRANAS is to provide methods to analyse retinal recordings at single cell
and population levels. With the advent of new techniques, the recording of the simultaneous
activity of groups of neurons provides a critical database to unravel the role of speci�c neural
assemblies in spike coding. The acquisition capacity of Multi-Electrode Arrays (MEA) has been
exponentially increasing over years [57]. Systems like the 256�MEA has become a standard
although new high-density MEA are now available such as the APS CMOS 4096�electrodes [15].
Using these systems, one can record from hundreds to thousands of neurons simultaneously in
the retina (and more generally in vivo or in vitro, from cultures of neurons, and from other
brain areas). As one gains more intuitions and results on the importance of concerted activity
in spike trains, models are developed to extract, from animal recordings, possible canonical
principles underlying spike coding. This is a major challenge with many potential outcomes.
Beyond the dream that population coding is ruled by a few �rst principles, several applications
could emerge such as the development of arti�cial systems having similar levels of performance
as biological systems. To this end, accurate tools are required to analyse and compare spike
trains, experimental or computer generated ones. Progress has been made recently to analyse
spike trains [53, 54, 32, 62, 61, 52, 51, 50]. Especially, the spatio-temporal aspects (memory)
and causality have been shown to be relevant for exploring neural activity [6]. For instance, [68]
and [60] demonstrated the importance of temporal statistics and [42, 40] developed new tools to
analyse spatio-temporal activity for large scale spiking networks. These methods shed a new light
on spike train analysis. However, they require time and expertise to be implemented e�ciently,
making them hard to use. The idea of developing a new software came from our motivation to
share these recent developments with the neuroscience community in a broad sense. PRANAS
integrates all our expertise in terms of spike trains statistical analysis. Note that other methods
analyzing correlations in massively parallel data using completely di�erent approaches have also
been proposed [26, 59, 65, 47].

The second goal of PRANAS is to provide a customizable retina simulator which could evolve
in synergy with experimental data analysis. Currently, there is a large and expanding body of
literature concerning models of retinal processing. There are three main classes of models. The
�rst class regroups the linear-nonlinear-poisson (LNP) models [43]. LNP models can simulate
the spiking activity of ganglion cells (and of cortical cells) in response to synthetic or natural
images [3] but they voluntarily ignore the neuronal mechanisms and the details of the inner
retinal layers that transform the image into a continuous input to the ganglion cell (or any
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4 Cessac & others

type of cell) stages. The second class of models has been developed to serve as a front-end
for subsequent computer vision task. They provide bio-inspired modules for low level image
processing. One interesting example is given by [2, 23], where the model includes parvocellular
and magnocellular pathways using di�erent non-separable spatio-temporal �lter that are optimal
for form- or motion-detection. The third class is based on detailed retinal models reproducing
its circuitry, in order to predict the individual or collective responses measured at the ganglion
cells level [44, 69, 31, 33]. In PRANAS, we are interested in this third class of models because
they allow to explore several aspects of retinal image processing such as (i) understanding how
to reproduce accurately the statistics of the spiking activity at the population level [41], (ii)
reconciling connectomics and simple computational rules for visual motion detection [29] and
(iii) investigating how such canonical microcircuits can implement the di�erent retinal processing
modules cited in, e.g., [21]. More precisely, the PRANAS platform has integrated and extended
the VIRTUAL RETINA simulator [69]1 initially developed in our team to do large scale retina
simulations. VIRTUAL RETINA has been used in several theoretical studies [37, 39, 1, 11, 12,
66].

This paper, aiming at presenting this new platform PRANAS, is organized as follows. In
Sec. 2, we give an overview of PRANAS and compare it with a selection of other tools currently
available focusing on spike train analysis methods. In Sec. 3, we present the main features of the
software. Illustrations and step by step procedures are given in several cases allowing readers to
reproduce them. In Sec. 4, we discuss future developments.

2 General presentation

PRANAS targets a broad community of scientists interested in exploring spike coding, in par-
ticular at retina level. It provides new tools for analyzing spike trains at the population level and
several methods to generate them, either with a prescribed statistics (including spatio-temporal
correlations) or by emulating the retinal response to a visual scene. This is done through a user-
friendly Graphical User Interface (GUI). PRANAS runs on multiple platforms (Linux, Mac
OS, Windows) and it supports parallel architectures. The software is provided as binary code
or as source code on request upon acceptance on the terms of the license given on the website
(http://pranas.inria.fr). Documentation, tutorials, and samples of spike trains are also available.

The GUI of PRANAS (version 1.0.0) has three main panels, as shown in Fig. 1:

� Function panel ( FP ) is the main panel containing Input/Output interfaces and functions.
It is organized in three sections: Data, Analysis and Simulation. (see Sec. 3 for more
details).

� The parameter panel ( PP ) allows one to set parameters related to the chosen function
from the function panel.

� The results panel ( RP ) contains the results. Several results can be displayed simultaneously
in di�erent subpanels, and each result can be exported as a �gure in a variety of formats
(e.g., PDF, PNG, JPG). The user can change the Number of views and which result
should be displayed in each subpanel. In most subpanels, there are icons on the left-hand
side to open, save, export or change plot settings (see Fig. 1(c)). Another example is shown
in Fig. 4(a) (Stimulus view) where the user can export, show/hide grid and spikes and
select neurons graphically.

1VIRTUAL RETINA website: http://virtualretina.inria.fr
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PRANAS: retinal analysis and simulation 5
Figure 1: GUI overview and basic visualisations

PPFP RP

(a)

(b)

(c)

Function panel Parameter panel Result panel

(b)

Menu bar

Example of Tooltip associated 
to Population analysis 

Customize the display or 
export it in different formats

About this module

Fit parameters considering a 
speciÞc probability distribution 
(potential).

Show bubble help
Tutorials
Support
About PRANAS

File     Help

Figure 1: Presentation of PRANAS GUI panels. (a) Function panel ( FP ) is the main panel con-
taining Input/Output interfaces and functions. It is organized in three sections: Data, Analysis
and Simulation. Note that in the Help option from the menu bar users can select Show bubble
help which will trigger tooltips giving information for each function. (b) Depending on the
function selected, the parameter panel ( PP ) gives the opportunity to set the corresponding pa-
rameters. (c) Results panel ( RP ) can show all results the user want. The number of sub-panels
and the windows to show can be changed. Note that for each result shown in a sub-panel, the
user can customize the display or export it in di�erent formats.

Finally, another convenient feature of the software is that user can save what he has done in
term of analysis in a HDF5 �le [70] (File>Save) and load it later to continue the work.

PRANAS is implemented in C++. It has its own dedicated libraries. It also uses other
libraries for storage (HDF5), analysis (GSL, SFMT), display and GUI (Qt4, Qwt, VTK, CImg).
Some parts of the software, especially the statistical estimations, run on multiple processors
thanks to OpenMP framework. The software takes all the available processors in the machine
automatically, without any interaction with the user. Parallelization allows to boost heavy
computations and save processing time and memory.

To our best knowledge there is no other platform integrating together the functionalities pro-
posed by PRANAS, to both analyse and stimulate retinal activities. There are however several
platforms performing e�cient spike train analysis. Table 1 provides a qualitative comparison
between PRANAS and a selection of such tools for spike train analysis. We note that the im-
plementation of PRANAS as a stand-alone application in C++/Qt4 rather than a library (such
as, e.g., the FIND toolbox) makes this tool readily available without the need of an external in-
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6 Cessac & others

terpreter, such as Python or the commercially available Matlab suite (MathWorks, Natick, VA).
Thus, access to PRANAS functions from a scripted analysis is performed via command line calls
(see Sec. 4).

CX FD NT SL NY OY ET SR NE SV PS
Version 2.12 2.0 2.0 1.00 0.1 0.3.5 0.3.0 0.3-2 5.037 0.4.2 1.0.0

Language Mat-
lab

Mat-
lab

Mat-
lab

Mat-
lab Python Python Python R VB Python C++

GUI        
Scripting           
Free binary           
File formats (Nex)         
File formats (HDF5)      
Rate histogram PSTH       
Population PSTH         
ISI          
Cross-correlograms          
Joint spike and stimulus
visu.  

STA      
PCA  
Spectral analysis       
MaxtEnt (x / x-t) GLM  
Raster generation    
... with Poisson / Non
Poisson    

... with VIRTUAL
RETINA  

Table 1: Comparison between a selection of existing software for spike train analysis. Ab-
breviations for software names (�rst and last initials) have been chosen for the presentation.
Following software is discussed: CX: Chronux [27], FD: FIND [38], NT: nSTAT [20],
SL: sigTOOL [30], NY: NeuroPy [56], OY: OpenElectrophy [18], ET: Elephant, SR:
STAR [45], NE: NeuroExplorer, SV: SpykeViewer [46], and PS: PRANAS. Note that
features selected in this table have essentially been chosen according to what PRANAS does.
It is not an exhaustive list and information applies to the time of writing. Software we mention
can have additional features not commented herein.

3 PRANAS main functions

3.1 Data

In section Data, user can load spike trains �les. Spikes may come either from real cells recordings
or from a simulated spiking neural network. They can be imported from di�erent formats such
as simple text �le (.txt), DAT �le for Windows (.dat), NEXUS �le (.nex) or HDF5 �le format
(.hdf5, see [70]) allowing to store not only the spikes but also other information related to
experimental protocole (e.g., time stamps, MEA characteristics).

Depending on how the spikes were generated, the user can also load other information such
as:

� The MEA con�guration for animal cell recordings, allowing the spiking activity to be
displayed relative to the grid of electrode.

Inria
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� The sequence of images in case of a visual experiment, allowing the spiking activity to be
displayed together with the stimulus but also to emulate a retinal response (see Sec. 3.3.2).

� The image time stamps, i.e., the precise time at which each image was shown, allowing to
perform Spike-Triggered-Average (STA) [8].

3.2 Analysis

3.2.1 Classical analysis

Once the spikes are available (simulated or imported), di�erent analysis can be performed start-
ing with basic visualizations and classical analysis such as peri-stimulus histogram, interspike
interval, and cross-correlation (see Fig. 2 and Example 1). The number of neurons used for the
analysis can be of several thousands, although the user can select subsets of neurons according to
di�erent criteria, e.g., individual activity or receptive �eld localization (if applicable, i.e., if data
allows to compute receptive �elds). Even for a large population of neurons (about 4000 neu-
rons), on any modern computer, the computational time of most of the functions in the classical
analysis is neglectable.

Example 1 How to obtain the peri-stimulus time histogram (PSTH) on a selection
of neurons having the highest spike rates?

1. FP Data>Spikes>Open

2. PP Browse and select the �le of spikes.

3. RP (Optional) In the sub-panel showing the list of neurons, click on Spike rate to
sort neurons with respect to their averaged spike rate, select the set of neurons with
higher spike rate and click on Keep selected.

4. FP Analysis>Peri-stimulus time histogram.

5. PP Choose thebin size (time step) in milliseconds and click on Compute.

3.2.2 Population analysis

With the current evolution of Multi-Electrode Array (MEA) recordings devices, it is possible to
record simultaneously thousands of neurons [15]. This opens up the possibility of analysing the
collective neuronal population activity, namely its spatio-temporal correlations. Characterizing
spatio-temporal statistics is a fundamental step toward extracting general population coding
principles in neuronal networks. For example, it has been observed in several vertebrate species
that, even if the pairwise correlations of retinal ganglion cell are weak, they are necessary to
explain the statistics of spikes [19, 22, 53, 54, 62].

Analysing spatio-temporal correlations is, however, a notoriously hard problem from a sta-
tistical perspective. The point is not only to measure pairwise or higher order correlations
but also to address adequately the question of their signi�cance in neuronal coding taking into
account constraints such as limited statistical sample, the reliability of statistical tests, the hy-
potheses underlying mathematical models and risks of over�tting [51, 52]. One possible way
of solving this problem is to use Gibbs distributions. Initially introduced in statistical physics
by Boltzmann and Gibbs [28] but currently used in a broader context, this general class of
probability distributions, constitutes a canonical paradigm to explain the spike statistics repro-
ducing as close as possible empirical correlations, without adding additional unnecessary assump-
tions [53, 54, 32, 61, 16, 17, 62, 61]. This method has been used to study pairwise correlations
(see [68, 42, 40] as well as more general spatio-temporal correlations [7, 67, 9, 42, 10, 24, 48, 25].
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Figure 2: Classical analysis

(c)

(b)

(d)

(a)

Figure 2: Example of classical analysis for a spike train shown in sub-panel (a). The following
estimations are shown: (b) Inter-spike interval (ISI), (c) Peri-stimulus time histogram (PSTH)
and (d) cross-correlogram. Data from electrode array recording of a mouse retina in response to
a moving pattern.

PRANAS provides a toolbox to compute a Gibbs distribution from the neuronal data i.e., to
estimate a probability distribution, reproducing as close as possible empirical space- and time-
statistics of a raster, without adding additional unnecessary assumptions (maximizing entropy)2.
In the current version, the population analysis toolbox of PRANAS focuses on stationary distri-
butions, i.e., the statistics are invariant under time-translation. We give �rst a brief explanation
of Gibbs distribution before explaining how to use PRANAS (see [67, 42, 40] for more details).

Below, rasters are denoted by ! . We assume that time has been discretized with some time
bin.The state of neuron i at time t is denoted by ! i (t) 2 f 0; 1g. We note by ! (t) the vector
! i (t) (it tells us the spiking state of neurons at time t). Therefore, a raster ! is mathematically
a matrix with N lines (number of neurons) and T columns (time bins in the raster). Obviously,
it is not stored this way in memory (we do not store 0s). A Gibbs distribution is a probability
measure � de�ned by a function E (also called "energy"). The probability of observing a raster !
of time length T , � [ ! ] is proportional to eE (! ) where E (! ) =

P T
t =1 � (! (t)). In the following � is

called "potential". A paradigmatic example of Gibbs distribution appears in the Ising 3 model.
Here � (! (t)) =

P
i bi ! i (t) +

P
i;j J ij ! i (t)! j (t) where the sums hold on neurons indices. The

terms bi ; J ij are parameters tuning the probability whereas the terms ! i (t); ! i (t)! j (t) depend
on the spike con�guration and are called "interactions" (self-interaction for the term ! i (t), and

2Note that this toolbox �rst motivated the creation of the GUI to manipulate these complex notions. In former
publications, software was named ENAS standing for Event Neural Assembly Simulations. After fusing of ENAS
and the retina simulator VIRTUAL RETINA (see Sec. 3.3.2) into the same platform, we decided to choose a
better suited name (PRANAS) to describe the functional scope of this unique platform allowing to (i) analyse
spike trains coming from simulations or MEA recordings, at single cells or population levels, (ii) simulate retinal
spike trains from a bio-plausible model, (iii) use additional dedicated tools for retinal recordings.

3The model initially proposed by Ising and Lenz in 1920 had only nearest neighbours interactions and constant
couplings. The potential form we use corresponds in fact to a spin-glass but we use here the terminology found
in computational neuroscience papers.
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PRANAS: retinal analysis and simulation 9

pairwise interactions ! i (t)! j (t)). Here parameters bi ; J ij are independent on time (stationarity
assumption) so it is su�cient to de�ne the potential � at time t = 0.

In the Ising model, there is no coupling of spikes at di�erent times so that the probability of
observing a raster of length T factorizes into probabilities of spike states ! (t): consecutive time
events are therefore independent. We say the statistical model has "no memory" in contrast
to the Markovian model presented now. A natural generalization of the Ising form is indeed to
de�ne the potential � as:

� (! ) =
LX

l =0

hl ml (! ) (1)

The terms hl are parameters tuning the probability. They correspond to bi ; J ij in Ising model
but they tune more general spike interactions. Again, these parameters are independent of time
(stationarity) so that we can de�ne the potential � starting from an initial time 0. The main
di�erence with Ising model is that now interactions involve spikes at di�erent times t1; : : : ; tn .
These interactions correspond to the terms ml (! ), with the general form ! i 1 (t1) : : : ! i n (tn ), i.e.
it involves spike events occurring at di�erent times. As an immediate consequence, consecutive
time events are not independent anymore. One can show the Gibbs distribution is, in this case,
the invariant probability of a Markov chain. Thus, statistics involves memory and has nonvan-
ishing time correlations. For historical reasons, related to the development of our research work,
we call from now the ml s "monomials" instead of "interactions". The monomials correspond
thus to the conjunction of events in the raster, varying the space and time. For instance, the
condition �neuron zero is �ring at time one, neuron two is �ring at time zero and neuron three is
�ring at time two� corresponds to m(! ) = ! 0(1)! 2(0)! 3(2). More generally, the times tk de�n-
ing a monomial are chosen in the interval [0; D ] where D is a positive integer characterizing the
memory depth of the Markov chain associated with the Gibbs distribution. The model range is
given by R = D +1. The potential range is directly connected to the complexity of the algorithm
analyzing data, as the higher the range the higher the computational time and memory load.
Gibbs distributions satisfy a variational principle: maximizing the statistical entropy under the
constraints that the average value of each monomial, � [ ml ] has a �xed value. Gibbs distribu-
tions are thus also called Maximum Entropy (MaxEnt) distributions. In our case, this value is
equal to average empirical value � [ ml ] computed from an experimental raster. In other words,
here is what our algorithm does: given an initial form of the potential � , �xed by the user (see
below), one seeks the parameters hl maximizing the statistical entropy under the constraints
� [ ml ] = � [ ml ]. In general, it is not possible to have the strict equality � [ ml ] = � [ ml ] so one
tries to approach it at best. Equivalently, we minimize the Kullback-Leibler divergence between
� , the "model" and � the empirical measure ("data"). In the ideal case of a raster in�nite
in time, this is a convex problem, and therefore there is a unique solution. For the realistic
case, the input raster is �nite, and several solutions can solve the problem [6]. The algorithm
starts from an initial guess of the hl s and computes the corresponding averages � (ml ) using a
Monte Carlo method. From this, it computes a variation of the hl s giving, if possible, a lower
Kullback-Leibler divergence (see [40] for details). We proceed this way until no improvement in
the Kullback-Leibler divergence is observed any more. At this point, modifying some parameters
(see next paragraph) can nevertheless still improve the minimization.

Let us now describe how to compute Gibbs distributions with PRANAS. There are many
(an exponential number) a priori possible potentials. In PRANAS we propose four prede�ned
potentials although the user can also de�ne his own one. The options are the following. Here we
characterize the potential by the list of monomials M which compose it.

� Bernoulli model: It takes into account individual neurons activity where all neurons

RR n° 8958



10 Cessac & others

are independent. The potential reads � (! ) =
P N

l =1 hl ! l (0) where N is the number of
neurons. Hence, monomials are of type �neuron i is �ring at time t� (Example: M =
f ! 1(0); ! 2(0); ! 3(0)g for 3 neurons). This model has range 1 .

� Ising model: This paradigmatic model from statistical physics has been used in neuro-
science in several papers such as [53, 54, 63, 64]. The corresponding potential has been
introduced above. The monomials are of type �neuron i is �ring at time t� and �neu-
ron i and neuron j are simultaneously �ring at time t�. Thus events are instantaneous,
and this model does not involve memory and causality (consecutive times are indepen-
dent under � , the Gibbs distribution). This model has range 1 (Example for 3 neurons:
M = f ! 1(0); ! 2(0); ! 3(0); ! 1(0)! 2(0); ! 1(0)! 3(0); ! 2(0)! 3(0)g).

� Pairwise + Triplets model: This model has been introduced by [16, 17]. In addition to
Ising terms, there are triplets of interactions (e.g. ! 1(0)! 2(0)! 3(0)). This model too has
range 1.

� Pairwise model. This is an extension of Ising model where monomials are of type �neuron
i is �ring at time t� (single events) and �neuron i is �ring at time t and neuron j is
�ring at time t + k�, 0 � k � D (pairwise events). This model integrates memory and
causality via time dependent pairwise interactions. (Example with range 2 and 2 neurons:
M = f ! 1(0); ! 2(0); ! 1(0)! 2(0); ! 1(0)! 1(1); ! 2(0)! 2(1); ! 1(0)! 2(1); ! 1(1)! 2(0)g).

� User. Here the user de�nes his own potential (Example M = f ! 1(0); ! 2(0); ! 3(0)
! 1(0)! 2(1)! 3(2); : : : g).

Example 2 How to calculate the Gibbs distribution of a spike train?

1. FP Data>Spikes>Open

2. PP Browse and select the �le of spikes.

3. RP (Optional) In the sub-panel showing the list of neurons, select a subset of
neurons and click on Keep selected.

4. FP Analysis>Population analysis.

5. PP De�ne the Potential, either from a �le or by setting the type (e.g., pairwise)
and the range4 (e.g., R=3). Set the Maximal pattern length. For example, if
you select 2, the program will seek in the data all spike events occurring within
2 successive time steps, and compare the probability of these events, predicted
by the model, to the empirical probabilities. In Simulation, choose what you
want to compute. Possible choices are:

(i) Potential: Fits the coe�cients of the potential.
(ii) Kullback-Leibler divergence: an estimation of Kullback-Leibler diver-

gence derived from the entropy estimation in [58] and the classical relations
between K-L divergence, � average of � and entropy [6].

(iii) Pattern probabilities: The con�dence plot.

6. FP Analysis>Population analysis>Parametric potential

4The product N � R somewhat de�nes the complexity of the model. The larger N � R the longer the simulation
and the memory load. We have been able to run up to N = 100 , R = 2 in reasonable times. Note however that the
statistical estimation of a so-huge number of neurons raises the classical problems (not inherent to our method)
of statistical estimation on a sample, which, e.g. for the retina rarely exceeds a few millions of spikes.

Inria



PRANAS: retinal analysis and simulation 11

7. PP Choose Initial coefficients: possible choices are Current (in the case
when you have made a run before and you want to keep hl s) or 0. For the
�rst run you can choose both as the initial parameters are anyway set to 0 (this
corresponds to start from a Bernoulli models where spikes are independent with
probability of occurrence 1

2 ). Set parameters of the Monte Carlo method to
speed up the process (see text for the role of each parameter).

8. FP Population analysis

9. RP Compute to do the estimation. The red bar at the bottom indicates that
computation is in progress.

Note that in PRANAS the user can �ne-tune the probability estimation and speed up the
computation in the �rst steps of the Monte Carlo method by acting on the following parameters
(in FP Analysis>Population analysis>Parametric potential):

� Convergence bound: The lower bound of error you require. Simulations stops when the
code reaches this value.

� Tolerance Coefficient: Allows to �lter monomials to compute hl s. For example, if
the event ml appears only, say 3 times in the raster you may consider that it is not
signi�cant and must be eliminated from the potential (1). In this case you set Tolerance
Coefficient to 3.

� Raster length: The length of the Monte Carlo raster used to compute the average of
monomials for the current values of hl s. This number must increase as you get closer to
the solution (typically when you do not get any improvement in the error).

� Spike flips coefficients: This de�nes the number of �ips per neuron and per iteration
in Monte Carlo methods [40].

� Delta: If the distance between predicted and empirical distribution is smaller than Delta
the Monte Carlo raster is not recomputed. Instead, the average value of monomials is
computed via linear response [40]. The number must be decreased as you get closer to the
solution (typically when you do not get any improvement in the error).

� Number of parallel iterations: We use two kinds of updating, based upon [14]: paral-
lel or sequential. Parallel update sets all hl s in one step. Number of parallel iterations
tells how many parallel updating of hl s are done before the program stops (and e.g. plots
the con�dence plot, when selected).

� Number of sequential iterations: Sequential update. It computes only one hl at each
step. It is better to use it at the end of the computation, to �ne-tune coe�cients.

Figure 3 shows di�erent visualizations of the results. In (a), we show a graphical view of the
potential’s coe�cients. In (b), we show the literal form of the potential � (! ). In this example,
it is

� (! ) = � 0:860273 w1(2) � 0:715493 w2(2) + � � � � 0:280176 w0(2)w2(2) (2)
+ � � � � 0:120281 w0(2)w3(2)w5(3) + : : : ;

where, e.g., w0(2)w2(2) corresponds to the event "neuron zero and neuron two are �ring at time
two whereas � 0:280176 is the corresponding coe�cient hl of this term in the potential. In (c), we
show a plot of monomials average value, with empirical average on the abscissa and theoretical
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average (predicted by � ) on the ordinate. In (d), we show the evolution of the Hellinger5 distance
between the model predictions and empirical data, versus the number of iterations. Hellinger
distance is natural here as it relies directly on the estimation of the average value of monomials.
It provides a quantitative measure of the goodness of �t. Finally, in (e) we show a con�dence plot.
This �gure consists of plotting, in log scale, on the abscissa the empirical probability of observed
spike blocks and on the ordinate the expected probability of those blocks for the model � . If the
matching were perfect one would have all points aligning on the diagonal. This perfect matching
is only possible, however, if the input spike train were in�nite. For �nite spike trains �uctuations
about the exact probability are observed, ruled by Central Limit Theorem. Namely, �uctuations
are Gaussian with a variance � l , depending on the monomial l and proportional to 1p

T
, T

being the raster length (number of time bins). Around the diagonal are drawn error bounds
corresponding to 3� l , where � is an estimated empirically. These bounds de�ne a con�dence
region: if the Gibbs distribution is a perfect estimation of the input raster then points in the
con�dence plot are distributed inside the con�dence region with a probability of 99:7% of the
expected averages. The con�dence plot provides a qualitative measure of the goodness of the �t.

Reducing the computation time has been a primary concern for us during the development
phase. In fact, the most time-consuming routine of PRANAS is for inferring the Gibbs Potential.
To face this problem, we introduced a new algorithm based on Monte Carlo sampling [42]. For a
large number of neurons, the Monte Carlo-based algorithm o�ers better computation time than
the algorithm proposed in [67]. With a cluster of 64 cores of 2.4GHz speed, PRANAS needs the
following amount of time to compute a target distribution (1 iteration): 5 min. for 20 neurons
with a pairwise model R = 2, 10 minutes for 40 neurons with an Ising model. To infer the
Gibbs Distribution, one needs 100-200 iterations on the hl estimation. For more details on the
scalability of this method see [42].

3.2.3 Receptive �elds estimation

Beyond tools to analyse spike trains at the single cell and population levels, PRANAS provides
speci�c instruments in the case when spike trains come from evoked activity of neurons from the
retina. The user can upload MEA characteristics, the sequences of images of the stimulus and
the time stamps. Given this information, PRANAS provides a method to estimate the neuron’s
receptive �elds. The method available in version 1.0.0 is Spike Triggered Average (STA) [8].
The STA can be computed for a single neuron, a subset of neurons or the entire population.
Example 3 describes the general procedure.

Example 3 How to estimate receptive �elds with STA method?6

1. FP Data>Spikes>Open

2. PP Browse and select the �le of spikes. Note that the user can select a subset
of neurons as in Example 1.

3. FP Data>Multi-Electrode Array>Settings

4. PP De�ne the MEA con�guration, so that, if neurons have a position relative
to the array, the spike activity can be displayed at the correct location.

5The Hellinger distance between the empirical probability � and the Gibbs probability � is d(�; � ) =

1p
2

r
P L

l =1

� p
� (m l ) �

p
� (m l )

� 2
.

6To test this example, one can use sample data available on PRANAS website: recording called mouse-
P39_17_06_14 (We are indebted to Evelyne Sernagor and Gerrit Hilgen, Newcastle University, who provided us
these data and authorized us to use them as a basis for examples.)
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PRANAS: retinal analysis and simulation 13Figure 3: Population

(a)

(e)

(b)

(d)
(c)

Cp

Cm

Figure 3: Population analysis view with N = 10; R = 2. (a) Graphic view of the potential’s
coe�cients values; the abscissa corresponds to an index associated to a prescribed order on
monomials: the N �rst coe�cients corresponds to single events (hence are related to �ring rate);
by clicking on the histogram bar one makes appear the coe�cient value and the corresponding
monomial. Ordinate give the value of the coe�cient attached to the corresponding monomial.
(b) Literal form of the potential. (c) Theoretical average value of monomials versus their empir-
ical average value. To which extents the model predicts the empirical data is drawn with this
representation. This allows checking that constraints on empirical averages are respected by the
model. (d) Decay of estimation errors versus the number of iterations allowing us to graphically
check the convergence of the estimation algorithm (red curve). In the �gure several successive
runs have been performed. The blue curve shows the evolution of error after each of these trials.
(e) Con�dence plot. Cp; Cm corresponds respectively to the upper and lower 3� bound associated
with Central Limit Theorem (see text).

5. RP Stimulus view shows the activity of individual neurons w.r.t. MEA array.
The user may choose a region of interest to select a subset of neurons. Note
that if you have a TEXT �le for spikes, no position is available, and we chose
to arrange neurons following their order, by rows and columns.

6. FP Data>Stimulus>Open

7. PP Browse to choose the directory containing the sequence of white noise im-
ages. Note that all images should be in this directory and ordered by name. All
standard formats are accepted (e.g., PNG, JPG, TIFF).

8. FP Data>Stimulus>Time stamps: Time stamps of the exact o�set of each
image during the experiment.

9. PP Browse and select the �le. Time stamps can be imported from a .txt (row
n contains the starting time of image n) or HDF5 [70].

10. FP Analysis>Receptive fields>Compute via STA
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Figure 4: RF

(a)

(c)

(b)

(d)

Figure 4: Receptive �eld estimation using the STA approach. (a) White noise image sequence
with spiking activity superimposed as red dots. (b) 3D volume visualization of the receptive �eld
of one neuron. (c) Temporal slices of the receptive �eld (RF (�; �; z)). Slices are in increasing time
order from top to bottom and left to right. Time period between two slices is 33ms. (d) Temporal
pro�le passing through the peak activity location of the spatio-temporal volume (RF (xM ; yM ; �)
where (xM ; yM ; zM ) = argmaxx;y;z RF (x; y; z).

11. RP Output directory: Choose the directory where the receptive �elds will
be saved, as a sequence of PNG �les and in HDF5 format. Choose the num-
ber of images to be averaged before each spike with Time depth (number of
slices). Then click on Compute.

12. FP Analysis>Receptive fields>Display allows four types of visualization.

13. RP The user can display the receptive �eld of interest by selecting the neuron
in Receptive Fields subpanel and Update views.

A receptive �eld is stored in a regular grid in a three-dimensional space. Each voxel in
that grid, denoted by RF (x; y; z), stores the value of the receptive �eld at each spatial position
(x � sd; y � sd) and temporal depth z � td, where sd and td denote respectively the spatial
and temporal resolutions. The temporal resolution is estimated from the time stamps �le as
the average di�erence between two successive time stamps. The number of time slices of the
receptive �eld, nf , is a user-de�ned parameter. The �rst spatial slice (x; y; z = 0) corresponds
to the average spike triggered stimuli at time � (nf � 1)td before the spike, the second slice
(x; y; z = 1) corresponds to the average spike triggered stimuli at time � (nf � 2) � td before
the spikes and so on. In PRANAS we propose several displays of that volume (2D and 3D), as
illustrated in Fig. 4.

The time spent on the estimation of receptive �elds depends on the parameters. For example,
on a computer equipped with a Intel Core i7@2.8GHz and 32 GB of memory it takes about two
minutes to estimate the receptive �elds of 4000 neurons with 64x64x12 voxels each.
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3.3 Simulation of spike trains

3.3.1 Simulation of spike trains from statistics

PRANAS gives the possibility to generate spike trains from Gibbs distributions. This can
be useful if, for example, one wants to generate spike trains with prescribed spatio-temporal
correlations so as to test a statistical method of analysis. There are two di�erent ways:

1. FP Simulation>ComputeSpikes>GibbsRaster>current: if distribution comes from a
population analysis (see Sec. 3.2.2).

2. FP Simulation>ComputeSpikes>GibbsRaster>File: if distribution has been de�ned by
the user and stored in a �le containing the Gibbs potential form.

A Gibbs probability distribution (de�ned by Gibbs potential of the form (1)) is naturally
associated with a Markov chain, with memory D = R � 1, whose transition probabilities can
be computed from the potential � [68, 6, 10]. The invariant distribution � of this chain is the
Gibbs distribution associated to � . Therefore, given a potential of the form (1) it is easy to
generate a sample raster distributed according to � using Monte Carlo method [42]. PRANAS
a�ords this functionality allowing to generate rasters with spatio-temporal correlations tuned by
the parameters hl in � .

3.3.2 Simulation of spike trains from a retina simulator

Another strength of PRANAS is to provide a way to generate spike trains that mimic retina’s
outputs. To do so, PRANAS has integrated and extended the VIRTUAL RETINA simulator
[69] formerly developed in our team.7

In a nutshell, VIRTUAL RETINA is a software to perform large-scale simulations of
biologically-plausible retinas. Given a retina con�guration which can be fully customized and an
input video as visual stimulus, VIRTUAL RETINA simulates the spiking output for di�erent
cell types. VIRTUAL RETINA has been shown to reproduce a broad range of experimental
data at single cell level, from salamander, cat and primate retinas, and has been used in several
theoretical studies [36, 37, 39, 1, 11, 12, 66]. The underlying model includes a non-separable
spatio-temporal linear model of �ltering in the Outer Plexiform Layer, a shunting feedback at
the level of bipolar cells, and a spike generation process using a network generalization of the
noisy leaky integrate-and-�re neurons to model Ganglion Cells (GCells). Note that VIRTUAL
RETINA was designed to be used via a command line (there was no GUI available).

By integrating VIRTUAL RETINA software into PRANAS platform, we allowed this
simulation software to be used through a GUI. We also extended VIRTUAL RETINA with the
aim to reproduce statistically coherent responses at a population level. Indeed, outputs of the
initial VIRTUAL RETINA version were successfully compared to experimental data at single
cell level but could not reproduce collective statistics at a population level. This is because GCells
in the early version were not connected. They were modelled by independent leaky-integrate and
�re neurons receiving their input from bipolar cells, but with no lateral connectivity (due to
amacrine cells - ACells - in the retina). As a consequence correlations in GCells spikes were only
due to statistics of the stimulus and overlapping receptive �elds.

In the new version of the retina simulator embedded in PRANAS, GCells are connected
laterally so as to explore the e�ects of connectivity on retinal responses to stimuli. More precisely,
the IPL is now composed of discrete time leaky-integrate and �re neurons introduced in [55] and

7VIRTUAL RETINA website: http://virtualretina.inria.fr. VIRTUAL RETINA is under Inria CeCILL-C
license, IDDN.FR.001.210034.000.S.P.2007.000.31235.
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studied mathematically in [4, 5]. We have chosen this model because of its simplicity, fast
response, and the fact that its collective dynamics are well known. In a nutshell, the model
comes from the time discretization of the leaky-integrate and �re model whose sub-threshold
dynamics reads:

C
dV
dt

= � gL (V � VL ) + I (t) + � B B (t); (3)

for V < � , where � is the �ring threshold. Here C is the membrane capacity, gL the leak
conductance, VL is the leak reversal potential, B (t) is a Gaussian noise (mean zero and variance
1) and � B controls the amplitude of this noise. Finally, I (t) is an external current. In our case,
this is the bipolar current coming from the OPL (see [69] for details).

Let � L = C
gL

be the leak characteristic time. We consider now a time discretization with a

time step dt (here it is �xed, dt = 1ms) and we set  =
�

1 � dt
� L

�
. Note that dt has to be quite

smaller than � L to have a reasonable description of the biophysics. Therefore  2 [0; 1[. Then,
the full dynamics (below and above threshold) of the membrane potential Vi of neuron i is given
by:

Vi (t + 1) = V i (t)(1 � Z i ) +
I i (t)

C
+

� B

C
B (t);

where Z is the binary spike label:

Z i =

(
1; if Vi � � ;
0; otherwise.

Thus Z i is 1 whenever neuron i spikes. Here 1 � Z i models the reset. In this equation, neurons
are not coupled. We add then a connectivity through synaptic weights Wij where neuron j (pre
synaptic) acts on neuron i (post synaptic) upon spiking. We have now:

Vi (t + 1) = V i (t)(1 � Z i ) +
I i (t)

C
+

1
C

NX

j =1

Wij Z j +
� B

C
B (t): (4)

For a complete description see [4, 5]. Clearly, this modelling of lateral connectivity, although usual
in the �eld of neural networks models, is rough when compared to the real lateral connectivity in
the IPL involving amacrine cells having a complex dynamics. Elaborating more realistic coupling
is under current investigations.

The simulator allows to tune the parameters leak ( 2 [0; 1]); neuronal noise (� B > 0);
membrane capacity (C); threshold (� ) and the connectivity matrix (W ). The connectivity be-
tween neurons is set through the connectivity matrix. One can simulate independent neurons
by choosing none or connected neurons using sparse or dense schemes. One can also upload a
prede�ned connectivity matrix o�ering the possibility to explore its impact on spike statistics.
For example, we provide on the website an example of ACells-like connectivity pattern.

Example 4 shows how to generate spikes using PRANAS and Fig. 5 illustrates an example
of simulation. Note that user can �nd online retina con�guration �les and videos sequences to
test the simulator.

Example 4 Running the retina simulator.8

1. FP Data>Stimulus>Open
8To run this example one can use data available on PRANAS website, for example the martin-walk image

sequence and the cat_X_cell_DLIF.xml retina con�guration �le which corresponds to the result shown in Fig. 5.
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Figure 5:

(a)

(c)

(b)

Figure 5: Spike generation from our retina simulator. (a) Input image sequence with spiking
activity super-imposed (white blobs). (b) Connectivity matrix chosen for the simulation, here
random. (c) Simulated spike train.

2. PP Browse to choose the directory containing the sequence.

3. RP Stimulus sequences subpanel: The sequence of images is loaded with a
default display duration of 100ms per image (Display time column). This value
can be manually set or de�ned from time stamps �le (see Example 3).

4. FP Simulation>Virtual Retina>Retinal configuration>Open9

5. PP Browse and select the XML �les containing the parameters of the retina.

6. FP Simulation>Virtual Retina>Retinal configuration>Customize: Once
loaded, the user can still change parameters of the retina.

7. FP Simulation>Virtual Retina>Compute spike.

8. PP Compute to get the spikes.

The time spent in the generation of spikes with the retina simulator depends on the param-
eters. For example it takes about six minutes to generate the spikes corresponding to Fig. 5
on a laptop equipped with a Intel Core i7-6820HK CPU@2.70GHz. This was obtained with the
image sequence martin-walk (200� 200 pixels, 41 frames) and the cat_X_cell_DLIF.xml retina
con�guration �le (100 neurons, sparse connectivity with 1000 connections out of 10000 possible
connections).

9Note that steps 4�6 can be skipped and one can directly generate spikes in step 7 using a proposed default
con�guration.
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4 Conclusion
In this paper we have introduced PRANAS, a new free10 platform for retinal analysis and
simulation. PRANAS provides a retina simulator allowing to transform any video into spike
trains, together with sophisticated methods to analyse spike trains, coming from simulations but
also experiments. As explained, PRANAS (version 1.0.0) includes a range of original methods
from the state-of-the-art [6, 69] which are now available to the neuroscience community. More
precisely, PRANAS intends to be useful for the neuroscience community in a large sense, i.e.,
not only experienced computational neuroscientists. To do so, we decided to make all methods
implemented therein accessible through a friendly GUI. No scripting is needed to run analysis and
simulation methods. This represents a major advantage to promote interdisciplinary neuroscience
and we believe that PRANAS helps in this direction.

However, we are certainly aware that this advantage could also be seen as a limitation of
the software. Indeed, inability to script analyses could be a limitation that can make systematic
analysis of large datasets tedious and error prone. It makes also di�cult to link the functionalities
of this toolbox to more extensive data analysis work�ow. For thoses reasons, we also o�er some
functionalities that run on the command line. A non-exhaustive list of tools that can be used
from the command line is SimulateRetina (simulate retinal response), Correlations (compute
the average cross-correlations of a given raster), SpikeTriggerAverage (compute the average
spike triggered stimuli.11 We expect to have the platform fully available with scripting in a
forthcoming version.

In this �rst release of PRANAS, we have focused on the following aspects:

� The user experience: We optimized the ergonomics of interactions between the user and
the interface. No scripting is needed to analyse or generate the spike trains.

� The richness of toolboxes: We developed a variety of methods ranging from classical tools
to population analysis, including a method for receptive �elds estimation. In addition, we
provide two simulators, one inspired in the retina, the other from rasters statistics analysis.

� The computational performance: We parallelized a selection of functions to make possible
to handle faster large populations of neurons12.

By putting together functions related to retina simulation and analysis, PRANAS intends
to be an original platform that will encourage joint modeling and experimental studies. The
synergy between these two areas of functionality will be in particular useful to de�ne better
retina simulators by confronting simulated output w.r.t. real cell recordings. A typical use case
is to start from a real cell recording of a retina, to analyse its receptive �eld structure, and use
that information to de�ne the XML retina con�guration �le so to de�ne a virtual retina having
similar characteristics as the real one. Another use case that we target is to start again from
a real cell recording of a retina, analyse spike train statistics and compare them with the ones
given by the simulator. Such a comparison is very informative and will suggest improvements of
the retina simulator to increase its biological plausibility.

10PRANAS is under Inria CeCILL-C license, IDDN.FR.OO1.190004.000.S.P.2014.000.31235. Binaries can be
freely downloaded.

11These commands can be found in the directory pranas/bin . Help of each tool is given with the command
line: toolName -h .

12Parallelization concerns every loop in our C++ code where iterations can be computed independently. To do
so, we used OpenMP so that PRANAS parallel processes can run on a personal computer equipped with multi-
core processors. More precisely, four functions were parallelized: (i) the loading of rasters for all �le formats, (ii)
the statistical analysis functions to generate potentials, compute divergence and estimate patterns probabilities,
(iii) the estimation of receptive �elds and (iv) the retina simulator.
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Here, we presented its main features, and we refer the interested reader to its website13 for
downloads and more information (see, e.g., tutorials to get started). We hope that PRANAS
becomes a useful tool for neuroscientists to analyse spike trains and we expect to improve it thanks
to the users’ feedback. Our goal is to progressively enrich PRANAS with the latest research
results, to facilitate the transfer of new methods to the community. Future work will focus
on improving several existing functions regarding e�ciency in time and memory consumptions.
We will include methods for population analysis in the non-stationary case as well as other
statistical analysis models. We are working on better methods for receptive �elds estimation [13].
We are also developing extensions of the retina simulator model so that it could serve as a
satisfactory model at a population level. Finally, as a general objective, we also plan to improve
the computational power of PRANAS in order to handle even larger networks.
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